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1. INTRODUCTION
1.1. Purpose

RCP Master 1.1. is a software tool for Time and Attendance (T&A) reporting and analysis.

1.2. Modules

The program consists of the following modules:
¢ employee data configuration
¢ work calendars configuration
¢ control point list (T&A readers)
¢ T&A event log

1.3. Data storage

Type: RCP Master data File
Date Modified: 2008-07-02 09:43
Size: 892 KB

Figure 1. Roger RCP Master datafile

All application data is stored in a MS Access database file (*.rta extension). Therefore, the

application may open many databases (using the File/Open command). The Tools menu makes
the following commands available:

¢ data file encryption/decryption (please note that working with an encrypted file can slow
the application down by about 15%),

¢ setting password for access to data file,
¢ data file compacting/repair.
Databases can be accessed programmatically from any IDE (Integrated Development

Environment) supporting MS Access databases or ODBC (Open Database Connectivity) — e.g.

Delphi, Visual Studio, Java). By default, the database is password-protected. The default password
is ,roger”.

1.4. Multiuser mode

The application allows for concurrent connections of several operators to one database at a time.
To enable such a mode of operation, database should be shared on a networked location, and the

operators should be given relevant read/write access rights. The file shared can be opened by the
File/Open command.

1.5. Data export and import

The program allows for manual data input and modification. It is also equipped with the following
import/export mechanisms:

¢ Import of configuration data and T&A event log from RACS version 4.2.5.38 and higher.
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¢ Import of T&A event log from T&A Access Pro file format.
¢ Import/export of configuration data and T&A event log from RCP Master in XML.

¢ Export of all the reports in Adobe Acrobat (.pdf), Microsoft Excel (.xls), Microsoft Word
(.doc), Rich Text Format (.rtf) and Crystal Reports (.rpt) formats.

¢ Additionally export of work time reports in XML.

roger
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2. REQUIREMENTS

RCP Master requires installation of the Microsoft .NET Framework 2.0 (available for download on the vendor’s
site at http://www.microsoft.com/downloads/details.aspx?displaylang=pl&FamilylD=0856each-4362-
4b0d-8edd-aab15c5e04f5).

The .NET Framework 2.0 requirements are listed below:

Supported operating systems: Windows 2000 Service Pack 3; Windows 98; Windows 98 Second
Edition; Windows ME; Windows Server 2003; Windows Vista Business; Windows Vista Enterprise;
Windows Vista Home Basic; Windows Vista Home Premium; Windows Vista Starter; Windows Vista
Ultimate; Windows XP Service Pack 2

Software requirements:

¢ Windows Installer 3.0 (except of Windows 98/ME which requires Windows Installer 2.0 or
higher). The Windows Installer 3.1 or newer is reccommended.

¢ Internet Explorer 5.01 or higher: For all the installations of .NET Framework, the Microsoft
Internet Explorer 5.01 or higher also must be installed.

¢ In case of Windows Vista the Service Pack 1 must be installed.

Disk space requirements: 280 MB (x86), 610 MB (x64).
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3. INSTALLATION AND FIRST USE

To install RCP Master you need to execute the installer (setup.exe). When the program is run for
the first time after the installation, it displays a question if the sample data from Demo.rta should
be loaded. If you answer Yes, the sample database will be read. Each time a data file gets opened,
the application displays a login dialog box as shown in Figure 2:

3

Figure 2. Login dialog box

In the demo file (Demo.rta), password for the ADMIN operator is empty (no password), so click
OK.

You can define any number of operators for the specific data file. For all of them you need to
configure passwords and set up access rights for performing particular application commands.

roger
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4. USE SCENARIOS
4.1. Preparing for work after installation

In order to prepare program for work, it needs to be properly set up. You need to perform the
following steps:
1. Create a new data file using File/New menu command.

2. Enter data on groups, employees, control points and T&A event types. You can do it
manually or import from PR Master (using Backup.zip or Config.xml files). To import data
use File/Import and export command.

3. Define calendar day types — choose Calendar day type definitions command from the
Tools menu.

4. Define work calendars — choose View/Calendars menu command.

5. Assign calendars to employee groups (or individual employees) — choose Assign calendar
to employees command from the shortcut menu.

6. Finally you can run a command for checking if work calendars have beeen assigned to all the
employees — select Tools/Verify data completness.

4.2. Work time analysis and reporting

One of the typical uses of RCP Master is to generate time an attendance (T&A) reports based on
employee T&A event registrations. Correct calculation of working hours requires that complete data
of arrivals/departures events is registered. The program is capable of detecting incomplete events
(by using the aforementioned Verify data completness command). They are indicated in any
report by an appropriate warning (red icon with exclamation mark together with a comment). Such
missing entries must be completed by the operator manually, i.e. by marking the entry as an
absence or manually inserting a missing T&A event (in the Work history window).

To generate T&A reports, you should typically perform the following steps:
1. Import T&A events log from file.
2. Use Verify data completness command.

3. Send notices to employees, for whom missing/incomplete entries exist in the event log, and
ask them for explanation.

4. Correct data manually (by entering an absence or inserting missing events to the T&A
events log).

5. Generate reports (you can use wizard for selected employee groups). After generation, the
wizard will send to every employee her/his reports using e-mail address configured in
employee’s data.
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5. RCP MASTER FUNCTIONALITY
5.1. Introduction

5.1.1. Home page

By default the program starts with the home page opened (Figure 3). There you can find commonly
used application’s commands, links to recently opened data files, and links to help files.

2 =R
File View Reports Tools Window Help
HFHR0ARBBRLE AKIOCO
" Home page 5 X
B

>
RCP Master Va' tion version)

Application for analyzing and creating work time reports
Version 1.1.4.0

0 — Common tasks

f& Open data file...

% Create new data file...

B Import TRA events

' Verify data completness...

44 Find work discrepancies against labour code...
& Employee report wizard...

% Find employee...

(\. - Recently opened
~ Demo.rta

Oj: - Help

@ Function description

@ FAQ

Fi Troubleshooting

Bs Open example (demo) file...

Read

Figure 3. RCP Master home page

5.1.2. Main window
The main window (displayed after the user logs on and the data file opens — sample is shown in
Figure 4) contains the following items:

¢ In the title bar shown at the top of the window there is application name (RCP Master),
the logged in operator ID enclosed in square brackets, and the active database path in
quotes.

¢ Below the title bar you can find the program menu. Its elements have been described in
detail in section Functionality description.

¢ The toolbar, which is located below the menu, contains shortcuts to the application's most
common commands and functions.

¢ The panel on the left side of the window contains a tree with hierarchical structure of the
data elements. Each section of the tree is assigned a shortcut menu with commands
relevant to the particular item (to show the menu you need to click the item with right

roger
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mouse button). When you double-click the item with left mouse button, the window is
opened with the document assigned to the item.

¢ On the right hand side of the window there are documents shown as tabs. Some
documents are split into two parts. The upper section contains the list, and the lower —
the detailed view of the selected list item. The windows contain buttons for invoking
commands.

¢ In the bottom of the main window there is application’s status bar containing information
about operations being performed as well as a progress bar.

4 RCP Master [ADMIN] Demo.rta” =R

File View Reports Tools Window Help

ER20ARBBLE AEIOC

E{Tree x Home page Groups All employees.~ Calendars 5 X
&4 Find: ] 2 | £ calendar list
=83 Groups + 3 XA S5
g H::Il El.’np;:‘,'iEE ((121j) Name Year Comment 1 ol
Aaministraton
88 Design Team (2) CMlreve  xos  menfi(ed) -
8 Management (1) Manufacturing I 2008 3-shift calendar o
Manufacturing IT 2008 3-shift calendar
-8 Team I (2) =
8 Team I (2) Calendar: Flexible X
=B %“ZEE‘ZG 1 of6 | b b
=
Flesible Calendar days
Manufacturing I o Edit 3 Remove | 5 Edit calendar days | ) Report [&] Shorteuts: §] Calendar day types
Manufacturing II
* ‘@lo X
Weekly 7-15 Su Mo Tu We Th Fri Sat |[Su Mo Tu We Th Fri Sst . ]
) L Weekly 8-17 " [ T 5 o | NNR - Flexible
Ry Control Paints s FEEEE 2| mEEEE e 1 NND  Extra working day
- [0/1/1] Indoors 13 | [ [ I el 1o | | o i 2 S s e
iﬁg[gﬂiﬂ;] gﬁc'tce hmISI“JIjI'gR;'EXI 20 |21 [22) (231241 125] 26 || 17 [e) el 200 120 22 22
_n[“,’,]a_”r" 27 |28] 281 |30l G 24 [25/(26 (27 28 29
i gl) [0/2/0] Office building - EN1

Bfw T&A event log

-8 2008
£ January March 2008 April 2008

£ February
Su Mo Tu We Th Fri Sat || Su Mo Tu We Th Fri Sat
1 R 5

2 D304 N8 6N 8 6 N D N9 I e 12

g [0Y 01 2 1314 15 || 13 14 15 16 17 18 19

16 [0 D180 190 200 2 22 | | 20 (21 (22 123 (241 125 26

23 24 |25 (26127 (28] 29 || 27 |28 (29 30

30 (31 il
< 1 | r
Ready

 — e W = s ——

Figure 4. RCP Master’s window layout

5.1.3. Reporting errors

RCP Master features error reporting mechanism. In case of unexpected error, the program displays
window similar to the one shown in Figure 5. It contains necessary information relevant to the
context and the source of the error. To send an error report you need to click Send report button.
The program invokes then a MS Outlook window containing e-mail with error report. The only thing
you need to do is to click the Send button in Outlook.
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v

Error not handled @

If you see this window, the application registered an emor. To help
us resolve the issue, send us a bug report by clicking on the [Send
report] button.

Report contents:

gSystem,Reﬂeob'on TargelinvocationE xception: Exceplion has beenthrown by A
(the taiget of an invocation. > System 10.FieNotF oundE xcepbion: Could not
{load fle o1 assembly TrystalDecisions Windows Fotms, Version=10.2.3600.0,
| Culture=neutral, PubficKey T oken=692fbea5521e1304" or one of s
\dependencies. The system cannot find the e specified

|Fie name: "CrystalDecisions. Windows. Forms, Version=10.2 36000,

| Culture=neutral, PublcKeyT oken=692(beaS521e1304'

l al Roges. TimeAndattendance. Foims. ReporlCalendars. cloi(Object])
ipawnelels]

[WRN: Assembly binding loggng is tumed OFF.

| To enable assembly bind falure logging, set the teqgistry value

| [HKLM\S oftware\Microsoft\Fusion!E nableLog| (DWORD) 0 1.

|

Add system info (Windows, .NET Framework)

[ Send report ] LSMdmnappﬁcelm] [ Conlirme ]

Figure 5. Unexpected error

5.2. Functionality description

5.2.1. File menu

The File menu is shown in Figure 6.

0

File

View Reports Tool

Mew
Cpen...
Save as.

Cloze
Import and export
Recent documents »

Exit

Figure 6. The File menu

5.2.1.1. New

Creates a new data file and opens it.

5.2.1.2. Open

Opens an existing *.rta data file.
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5.2.1.3. Save as

Saves currently opened data file in the file under different name.

5.2.1.4. Logout

Closes all the editing windows of the current data file and displays the home page of the program.

5.2.1.5. Import and export

Opens the data import/export wizard. When the user has selected Import T&A event
registration from another software action, the wizard performs the following steps (shown in
figures 7-9 below):

¢ Step 1. Select T&A data import/export action (Figure 7).

Data import and export ==

Select action:

Import data
Export data

Description:

Mesd -= ] [ Cancel

Figure 7. Data import and export wizard — step 1
¢ Step 2. Select data file format (when importing data from PR Master — Figure 8).

¢ Step 3. Select location to your T&A event file (Figure 9). Using available options you can
choose a method of resolving conflicts in case, the imported value is already in database.
If you choose Replace duplicates with imported items, duplicate values existing in
the database will be overwritten by the imported values. The Do not import duplicates
option skips duplicated records. Two T&A events are assumed equal, if their date/time,
reader ID and event type are identical.

roger
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Data import and export

Select TA evert file format:

F{EF‘ Master {by Roger) |

Té&A Access Pro (by Palman)

<Back || MNet> || Cancel

Figure 8. Data import and export wizard — step 2

Data impoert and export

TA event file to impaort:
2% Users Radek Mendd Documents'radekrep | Select...

Options:
i@ Replace duplicates with imported tems
™) Do not import duplicates

<Back || MNet> || Canesl

Figure 9. Data import and export wizard — step 3

5.2.1.6. Recent documents

Shows a list of recently opened data files. Clicking an item on the list opens the selected document.

5.2.1.7. Exit

Closes the active datafile and exits the application.

roger
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5.2.2. View menu

The View menu is shown in Figure 10.

WI Reports  Tools  Win
&1 Employee groups

£ Employees

HH Calendars

ﬂ Control points

s TAeventleg

o Homepage

B Mavigation tree

&9 Previous document

wd Mext document

Figure 10. The View menu

5.2.2.1. Employee groups

Opens the Employee groups window. As mentioned above, the document window is composed of
two parts — the upper section is usually a list (e.g. a list of employee groups), and the lower — the
detail section, where information related to selected list item is shown (in Figure 11 it is the group
Administration). The detail pane can be closed at any time by clicking the cross icon on blue
background located in the right side of detail pane’s title bar. To reopen it, click the Show details
button on the right side of the upper pane.

Employee groups ¥ X
€ Employee group list

+ X X B |3

Mame Comment 1

[ Administration

Design Team

Management

Team I

Team II

Team III

Group: Administration X
" | 1 D'F 5 P bi

Details

CF Edit X Remowve

Mame:  Administration

Comment 1:

Comment 2

Figure 11. Employee groups window
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Items on the list can be added, edited or removed. In addition, there can also be other commands
on the toolbar, such as Refresh, Create report, and so on. They can be different depending on
the particular window selected. Clicking the Edit button displays the Edit employee group

dialog box (Figure 12).

Edit employee group
=1 A dministration |
Comment 1:
Comment 2:

QK Cancel

Figure 12. Edit employee group dialog box

Required fields in edit windows are marked in yellow (in this case the Name field is required).

5.2.2.2. Employees

Opens the Employees window (Figure 13).

Employees > X
Q Employee list
& = X | D) |44 Find last name: L HEG [#] Shortcuts: @8 Employee groups
Last name First name T8AID Group Calendar Year | %
Arab Muhannad 001 Management Flexible 2008
| » Arispe Anastatio 004 Team I Manufacturing I 2008
Bonds Elizea 010 Design Team Weekly 3-17 2008
Buckner Thorvald 005 Team I Manufacturing I 2008
Chambless Rudi 006 Team II Manufacturing II 2008 2
Chevere Lucinde 007 Team II Manufacturing II 2008
Corpuz Demelza 011 Design Team Weekly 3-17 2008
Gerstner Herbert 002 Administration Weekly 7-15 2008
Huffman Allison 003 Team III Manufacturing III 2008 |
O |Mckay Branden 003 Administration il

Employee: Anastatio Arispe
M 4|2 of11 | b k|

Details |Work histary I Leave entitements I Wark calendar

Photo:

THAID: 004
Firstname: Anastatio
Last name:  Arispe

Group:  Team I

Calendar:  Manufacturing I (2008)

Hire date:

Dismissal date:

[ Edit X Remove | J Report [@] shortcuts: ] Calendars |

Figure 13. The Employees window

The detail section of the employee window contains four tabs:
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Details

The Details tab contains the following data about employee (Figure 14):

¢ Photo — employee’s picture (automatically resized to save space in the database).
Pictures (as any other data) are stored in the currently opened datafile.

¢ T&A ID — employee’s unique ID. An employer is identified in the program using this
unique identifier. Thanks to this, there can be employees of the same first name and last
name in the database, Moreover, changing names has no influence on the proper
employee’s identification.

¢ First name and Last name.

¢ Group — indicates the employee group, the employee belongs to. Grouping accelerates
calendar assignments, reporting, etc.

¢ Calendar — used for employee work schedule assignment. T&A calculations are based on
calendar contents as well as a T&A event log.

¢ Hire date and Dismissal date — (optional fields) are used to determine a time interval
for TRA calculations for the particular employee. For example, if you create a report for
an employee, who was dismissed in mid January, you should enter a dismissal date as
well. Otherwise the program will report missing entries in the event log.

¢ E-mail — the field contains an e-mail address, which will be used to deliver generated
reports (as attachements in PDF format).

+ Comments — additional data.

Employee: Eliseo Bonds X
M 4|3 of11 | b k|

Details |'.-'-a'0rk histary I Leave entitements I Work calendar
= Edit X Remove |5 Report [2] Shorteuts: 5 Calendars

Photo:

T&AID: 010
Firstname: Eliseo
Lastname: Bonds

Group:  Design Team

Calendar:  \Weekly 8-17 (2008)

Hire date:
Dismissal date:

E-mail:

Comment 1:
Comment 2:
Comment 3:

Comment 4:

Figure 14. The Details tab of the Employees window

Clicking the Edit button displays the Edit employee dialog box (Figure 15), where you can modify
employee’s data. Required fields are highlighted in yellow. Red icon with an exclamation mark
shown on the right of the Calendar field indicates that employee’s data is invalid. When you move
the mouse cursor over the icon, the message is displayed that the calendar has not been assigned
to the employee. Such red icon accompanied with appropriate comment indicate invalid data also in
other editing windows.
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Edit employee @

Phota:

TAID: |
First name:  Eliseo

Last name: Bonds

Group: [DesignTeam v]

Calendar: [ Veskly 8-17 (2008) -]

Hire date: [0 9 stycania 2008 E~

Date of dismissal [ 9 stycznia 2009 E~
E-mail:

Comment 1:
Comment 2:
Comment 3:

Comment 4:

Cancel

Figure 15. Edit employee dialog box
Work history

Contains results of T&A calculations regarding time spent at work in the period selected. In the
pane’s title bar the calendar’s name is shown. Next to it there is Time range dropdown list. The
list contains month names, and in the bottom there is the Select time range... command. Clicking
the month name causes recalculation for the month selected. When you select the Select time
range... command (Figure 16), you will be presented with the dialog box, where you can more
accurately determine calculation period (up to minutes):

Select time range... @

h : I Month:

e atala]

o
o

ST e o

i@ Time period:
From: |[¥]2008-01-01 | |[¥]00:00 |2
To: |[¥]2008-12-311 « | |[¥]23:55

L1 13

[ OK ] ’ Cancel

Figure 16. The Select time range... dialog box

The Work history window is composed of two basic views — Attendance (the calculation
results), and the Event log (the filtered list with events pertaining to the employee in the selected
time range. The calculation result of attendance data for the employee can be shown in various
preview modes (by clicking View commands on the toolbar).
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View: List of days

The most generic view of hours spent at work in the form: list of days — total time, time to be
accounted for (Figure 17). On the right side of the window, the calendar is displayed showing days
in colors representing particular day and absence types. In the bottom of the window the
calculation results summary is displayed (remaining hours to work, the total time to be accounted
for, the balance, as well as information regarding night hours, overtime, sundays, holidays, and so
forth).

View: Calendar day details

It contains all the information included in the List of days view. Additionally, each day has been
analyzed in detail. Attendance periods are shown chronologically using calendar day and T&A event
definitions. So, it includes compulsory breaks, work time, overtime, and so forth. Late arrivals,
early departures, and other discrepancies to the work schedule (work regulations) are indicated in
the list by the warning yellow icon accompanied with the relevant comment (early departure, late
arrival, etc.). The same icon is shown on the calendar in the right side of the window (see Figure
18). If you click a date on the calendar, the list is scrolled to the day selected.

View: Total time

It contains all the information included in the List of days view. In addition for each day, the total
time for the specific attendance types are shown: such as total time of cigarette breaks, other type
of breaks, work time, hours outside the office, and so on (Figure 19).

View: Discrepancies

In this view, all the discrepancies to the employee’s work schedule (work regulation) are shown
(late arrivals, early departures, exceeded break limits — e.g. cigarette breaks, and so on). In the
example shown in Figure 20 it is for instance the early departure logged on January, the 24th. This
view is most often used for employee’s work analysis and for correction missing log entries. Events
can be inserted using the Add command in the toolbar. You can also edit absence by the Edit
absence command shown above the calendar, on the right side of the window.

Employee: Eliseo Bonds X
4 4 |3 of 11 | b B

Details | '

Vork history | Leave entitlements | work calendar
Calendar: Weekly 8-17

“7 Time range: January 2008 - Shortcuts: (| Calendars &) Calendar day types (=} TA types/IDs

Time and attendance Calendar

Attendance | Event log :E =]

1 of23 | p Pl | ¥ Add & Edit X Remove | [4] 2] Calendar day details X Total time

% Edit absence

View: 2= List of days

Time to be i
Start Attendance type e P Lo Edited

I T N ] ™ N N

fe Th Fri_Sat

Comment Total ime

1/3/2008 || wworking day
17472008 ||
1772002 ||
1/z/2002 || v
1/z/2003 || v

Norking day

1/12/2008

'orking day
Vorking day
Working day
Working day
Working day
Extra working day 8-17
1/14/2008 [l working day

8-17
8-17
8-17
8-17
8-17
8-17
3-17

8-17

1/15/2008 | [l working day 3-17

TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:
TOTAL:

9:14
9:13
8:42
9:01
9:14
9:07
9:05
9:18
o:16
O=11

8:02
8:01

742
8:07
8:02
7:56
8:00
8:00
8:00
8:15

1

Oooooog@zeEa

= Total time

Code Attendance type

Work
SN Breskfast break

PO |Lunch break

Total time

Time to be
accounted for

182:02
5:45
22:39

Sundays
public hol\days Night hours

0:0

Remaining hours:
Hrs to be accounted for:
Balance:

Late arrivals and early departures:
Sundays, holidays:

Might hours:

Overtime:

198:00
182:21
-15:39

2:00
0:00
000
0:00

Figure 17. The List of days view
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Employee: Eliseo Bonds X
P43 of11 | b bl

Details | Wark histary |LEavE entitements I Work calendar

| Calendar Weekly 8-17 | % Time range: January 2008 -

Shortcuts: Calendars Calendar day types =} TA types/IDs
|

Time and attendance Calendar
m g ‘L'EEd\t absence
P41 of166 | b bl | 4 Add [ Edit X Remove | (4 | View: 3= List of days [EE] Calendar day details | 3 Total time B ER—
Start Attendance type Event Cu.mml Comment Total time nsylabe Edited i Su Mo Tu We Th Fri Sat
point accounted for D
8:00 AM Work T&A - Entry Office buildin, ., 2:00 2:00
10:00 AM Breakfast bresk 0:15 0:15
10:15 AM Wark 2:55 2:55
1110 FM D Lunch break Lunch bresk Office buildin. .. 0:56
2:06 PM . Waork T&A - Entry Office buildin. .. 1:56 1:56
4:02FM On-demand leave On-demand ... |Office buildin... 0:58
402 PM early departure 0:58
7:55 AM Work T&A - Entry Office buildin. .. 2:05 2-00
10:00 &M || |Breakfast break | 0:15 0:15 |~
Z Total time Remaining hours: 198:00
I e to be Sundays, ] Hrs to be accounted for: 18221
Codk Attendance type Total time accounted for | public holidays Night hours Balance: - 15:39
Late arrivals and early departures: 2:00
SH |Breakfast break 545 0:00 0:00 Sundzys, holidays: 0:00
Might hours: 0:00
(PO [Lunchbreak 22:33 Overtime: 0:00

Figure 18. The Calendar day details view

Employee; Eliseo Bonds
P43 of 11 | b B

Details | Work history |Leave entitements | Wark calendar

| Calendar, Weekly 8-17 | "7 Time range: January 2008 +

Shorteuts: Calendars Calendar day types ] TA types/IDs
|

Breakfast break

D Lunch break

On-demand leave

1/3/2008 Working day 8-17

Work

Breakfast break

D Lunch break

1/4/2008  Working day 8-17

Z Total time

Code Attendance type Total time

Time to be
accounted for

Sundays,
public holidays

Night hours

M PR work
5N |Breakfast break 5:45 5:45 0:00 0:00
[ |Fo  |Lunch break 22:33

Remaining hours: 198:00

Hrs to be accounted for: 182:21
Balance: - 15:39

Late arrivals and early departures: 2:00
Sundays, holidays: 0:00

Might hours; 000

Qvertime: 0:00

Time and attendance Calendar
Attendance |Eventlog mlﬁ 4 Edit absence
4|1 of 9% | b Ml | & Add [F Edit X Remove | [d] | View: = List of days Calendar day details | X Total time = January 2008
Sundays . -
. Time to be i Might " Su Mo Tu We Th Fri Sat
Start Attendance type Total time Ermr T public e Edited E
holidays

Figure 19. The Total time view
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Employee: Anastatio Arispe b
H U of 11 | b bl
lDa—mi\sl Vork history | Leave entitiements | Work calendar
¢ Calendar: Manufacturingl | ¢ Time range: None = [] shortcuts: mCa\endars G] Calendar day types 'Lj TA types/IDs
Time and attendance Calendar
m ,EIE‘ HEditabsen(e
i 41 of8 | b Bl | % Add [ Edit X Remove | (3 | Views = List of days [:] Calendar day details E Total time 8 January 2008
Start Attendance type Total time 1‘221}?@3 for Edited Su Mo Tu We Th Fri Sat
17272008 [l 06-00 - 14:00 1AM S
6 (7,89 101 12
13 | D Y

2021 2 23 M5 %
27 (2829 (30 /R

¥ Total time Remaining hours: 184-:00
Tme o be Sundays N Hrs to be accounted for: 182:25

Code Attendance type Total time accounted for | public holidays Might hours Balance: -1:35

B PR Work Late arrivals and early departures: 1:35
FNP | (Cigarette) bresk 0:28 0:28 0:07 0:00 sundays, holidays: 200
Night hours: 40:00

SN |Breakfast break 5:45 5:45 0:15 115 | - Crvertime: 0:00

Figure 20. The Discrepancies view

Leave entitlements

According to the labour code, employees are entitled to paid or unpaid leaves. In the Leave
entitlements tab (Figure 21), you can enter values describing yearly leave limits for the particular
types (leave types can be defined using Tools/T&A type definitions command). In addition, in
this window the number of days for the specific leave type and the remaining humber of days are

displayed.

PVearm 2008 | &+ = X | A [@] Shortcuts: = TA types/IDs [
Color  Code Leave name Yearly Used Remaining Incuded

[) uw Reqgular Vacation 26 o 0
B (e Unpaid leave 5 a 0
P |one | Occasional leave - family member care a a a
B uo Occasional leave Q 0 0
Il Vv |Parental leave - child care 0 0 0
U [ Maternity leave 0 o il

Figure 21. Leave entitlements tab

Work calendar

All the employees have work calendars assigned to them (Figure 22). However, from time to time,
it is necessary to modify work calendar of particular employee. It can be caused by, for example,
replacements done between employees, compensation for past or future absences, and so on.
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Employee: Muhannad Arab
1 ofl | b b

| Details | work history [ Leave entitlements | Work calendar |

Calendar: Flexible ﬁ Correct employee calendar days | 4] | View: =j Report Shorteuts: (& | Calendar day types

Su Mo Tu We Th Fri Sat ||5u Mo Tu We Th Fri Sat £
2 34 5 il 2 72 14:00-22:00
¢ EEE 2 || : EEEE 9 NMR  Flesible
13 [ 551 6] 7 [A8] 19 | | 1o [0 2 S A9 S 1e NMD  Extra warking day
20 291152 |25 201550 26 || 17 (RS B0 2 | 22 DO Dayoff
27 |28 /28 30 5 24 [B51|28 20 31 E

Su Mo Tu We Th Fri Sat Su Mo Tu We Th Fri 5at
| 1 || 1 2 1 4 R |

Figure 22. Selected employee’s work calendar

To modify the calendar assigned to the employee, you need to click the Correct employee
calendar days button. Days modified in the calendar are marked by a border (note the 16th and
18th January in Figure 22 above). To display original or(and) modified calendar days, you need to
select appropriate option in the View menu). The modified calendar days replace the original ones.
In Figure 22, to the 16th January the ,Day off” status, and to the 18 January, the ,Working day
14:00-22:00" status have been assigned. The modifications apply for the selected employee only.

Reports

In the example presented above, the results of work history calculations have been presented using
different views. The program allows for generating reports from any type of view. Reports can be
generated by the Create report command from the particular window (the printer icon) or, in case
of more complicated reports, using a report wizard. Commands for creating reports can be invoked
from many locations, e.g. from the navigation tree, group window, employee’s detail pane. Using
the wizard, you can generate summary reports (for selected employee groups or for all the
employees) as well as for individual employees. These reports can be automatically sent as
attachements in PDF format using e-mail addresses set up in the employee’s data window. Below
you can find successive report generation steps for the individual employee (to invoke the wizard,
you need to click Report command in the employee’s detail pane — the first tab — or in the
navigation tree, from the shortcut menu of the selected employee — the Report wizard...
command).

Step 1. Select report types to generate. In the example below (see Figure 23), the generic report
on work time, the report on discrepancies to work regulations (late arrivals, exceeded break limits
— e.g. cigarette breaks, and so on), the leave entitlements report (the current state of the leave
usage) and the work calendar report, have been selected.
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Report "Anastatic Arispe”

Select report type:

TaA -list of days
ThA -list of days details
TaA -total time per day

T&A -total work time in a time span
Yeary lzave entitlemants

T&A - discrepancies against work regulation

Work calendar

J |

Cancel

Figure 23. Selecting report types to be generated

Step 2. Choose period, for which the reports selected are to be prepared (Figure 24).

Report "Anastatic Arispe”

Report time range:

@ Moanth:

| 2009 Ii" [.Januar_',.r

(™) Time period:

From: |[Z]2008-0101 | [[Z]00:00 |

To: (20080201 ~|[[@12359 |

Cancel

| |

Figure 24. Selecting time range for generating selected reports

Step 3. Select destination directory for PDF files containing reports generated (Figure 25). In
addition, you can select option for sending reports to employees as e-mail attachements.
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Report "Anastatio Arispe”
Cptions:

[11]
[}
i
1P
I
c
o

@ Employee report
[ Send reports to employees as attachments

Write reports (PDF)in directory:

C:sers' Radek Merk Desktop

<Back | MNew> ||

Cancel

Figure 25. Selecting destination directory for generating reports

Step 4. Displaying a progress window for the process of generating reports (Figure 26). After

generation, the summary message is displayed.

Report "Anastatio Arispe”

[}
1}
1]
ol
[41]
11}
T

=)

Completed

Result:

5

Creating repart "Day list™.. QK.

[um]

[x1]

0
=
1]

Start:11:53 AMCreating reports for the employee: Arspe Anastatio [0
Saving report "Day list"...ERRCOR: "Could not find a part of the path 1

Mesd = Close

Figure 26. Report generation progress window

Apart from reports generated as PDF files using report wizard (most often for list of elements such
as calendars, readers, employees, groups, and so on) there are reports which are displayed as
documents. In Figure 27 you can find sample report List of employees (invoked by the

Reports/Report "employees"” menu item).
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Home page | Employees Report "Employees” | s X
w S8 & # -
[ Administration Main Report |
[ Design Team
H -
[ Management —
o[ Teaml
[ Team@ Report "Employees” Page 1of1
L[] Team D
Prepared: 1/10/2009 11:56:014M QOperator: ADMIN RCP Master 1.1.4.0
Group linistration ]
Last name: Firstname T&AID Calendar Year E-mail Hire: Dismissal Comment 1:
Gersiner Herbert 002 Weekly 7-15 2008
M Branden 003
Group Design Team 1
Lastname:  Firstname T&AID Calendar Year E-mai Hire Dismissal Comment 1:
Bonds Elisea 010 Weekly §-17 2008 L4
Compuz Demelza 011 Weekly 8-17 2008
Group Management ]
Last name: Firstname T&AID Calendar Year E-mai Hire: Dismissal Comment 1:
Arsh Muhannad 001 Flexible 2008
Group Team I 1
Last name: Firstname T&AID Calendar Year E-mai Hire: Dismissal Comment 1:
Arispe Anastatio 004 Manufacturing 1 2008
Buckner Thorvald 005 Manufacturing I 2008
Group Team IT 1
Last name: Firstname T&AID Calendar Year E-mail Hire: Dismissal Comment 1:
Chambless Rudi 006 Manufacturing T 2008
Chevere Lucinde 007 Manufacturing T 2008
. -
Current Page No.: 1 Total Page Mo 1 Zoom Factor: 100%

Figure 27. Report "Employees” displayed in document window

The report is ordered by the employee group name (displayed on the left side of the window).
When you click specific group name, the report will be scrolled to the location, where the data of
the selected group begins. Reports can be printed and exported in many different formats such as:
Crystal reports (.rpt), Adobe Aprobat (.pdf), Microsoft Excel (.xls), Microsoft Word (.doc), Rich
Text Format (.rtf).

5.2.2.3. Calendars

Opens the Calendars window (Figure 28). On the right side of the window, the legend is displayed
explaining colors representing particular day types on the calendar.

Calend 5 X
ﬁ Calendar list

* o X455

Mame Year Comment 1 nl
» Flexible 2008 Mon-Fri (flexible) =
Manufacturing I 2008 3-shift calendar -

Calendar: Flexible X
4 4 |1 of6 [ b B
Calendar days

5 Edit X Remove | ZHEdit calendar days | = Report [&] Shortcuts: (& Calendar day types

g
Su Mo Tu We Th Fri Sat [[Su Mo Tu We Th Fri Sat |[[Su Mo Tu We Th Fri Sat D_
1 208 5 i 2 1 E MNR Flexible

& (7| B9 [1011 12 3[4 0567 Ne 9 2 (345 6|7 8 MND - Extra working day

13 4 15 16 1| N8 19 | | 10 S 20 130 i 1S 16 g [0 1112 13 14| 15 b

20 2022 123 1241 125) 26 || 17 J18) 190|200 (210 122 23 || 16 NI U8 1S 200 121 | 22

27 281129 30 31 24 2511261 27|28 |29 23 24 2526|271 28] 29

30 |31
April 2008 May 2008 June 2008
Su Mo Tu We Th Fri Sat [[Su Mo Tu We Th Fri Sat [[Su Mo Tu We Th Fri Sat
2@ s || R -

Figure 28. The Calendars window
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Clicking the Edit calendar days button displays the Edit calendar days dialog box (Figure 29),
where you can modify the calendar. On the right side of the window, there is a legend with day
types, which can be assigned to the calendar. Assignment is done by selecting days with left mouse
button. Then you need to click right mouse button and select the day type from the shortcut menu.
To remove an assignment, you need to select apropriate days on the calendar, and choose the
Remove assingnment command from the shortcut menu. At the top of the window there is
Insert holiday menu. When you expand it, you can select predefined public holidays for inserting
into the calendar.

oS! Edit calendar days = @
L Select days - 2 Clear selection jln"&rtholicla).fr -
. . . < Assign to selection
Mo Tu We Th Sat Mo Tu We Th Fri Sat || Su Mo Tu We Th Fri Sat
23 4 1 2 1 )(Clearassignment
c FEERE 2 | EEEEE || EEEEE [ EEE
13 [ 15 F161 B 18 19 | [ 10 J 12 S e e L A0 91 49 193 44 15 Bl DR Working day 7-15
2 ElEE BN % || 7 FEIFEEm) < Sclect by rule 7 2 = | B DR Woring day 817
27 | 28112930 [3i 2¢ |35 (36|37 [| &# Clear selection 28 29
Il CD7  Extra working day 7-15
DDE  Bdra working day 817
Z1 06:00 - 14:00
April 2008 ay 20 Working day 8-17 1 73 1400~ 2200
Su Mo Tu We Th Fri Sat (| Su Mo Tu We Fri_Sat B Z:  22:00-06:00
NN 5 Extra working day 8§-17 NNR  Flexble
6 7 [8 9 101 12 4 86 T 06:00 - 14:00 6| 7 NND  Edtra working day
13 415 160 1 18 19 | [ 11 [120 113 4 a0 - 27 13 14
14:00 - 22:00 DO Dayoff
20 8
20 2791221123 (24 |25 26 | [ 18 19820 |21 2200 - 06:00 20 21
27280 3 25 |26 27 |28 27 28
Flexible
Extra working day
Day off
July 2008 m )( Clear assignment m al

Figure 29. Edit calendar days dialog box

In order to make selecting days within the whole year easier — for instance by some rule (e.g. all
the Mondays, Wednesdays and Fridays in June and August), you can use the command Select
days by rule which can be invoked at the top of the window or from the context menu (Figure
30).

[ By rule... [£5]

Monday

] Tuesday

Wendesday

] Thursday Range

Friday From: 1 stycznia 2008 [El~-
] Saturday
] Sunday

To: 31 grudniz 2008 [E-

oK ] [ Cancel ]

Figure 30. Selecting days by rule
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5.2.2.4. Control points

Opens the Control points window (Figure 31).

Control points ¥ X
& Control point list
+ X B|S
T&A point ID Name Comment 1
T
T /21 Office building - EXIT
0f1f0 Factory - ENTRY
a/2f0 Office building - ENTRY
Control point: Indoors X
1 ofd | b M
& Edit X Remove

T&A PointID:  0f1/1
Mame:  Indoors
Comment 1;

Comment 2:

Figure 31. The Control points window

Clicking the Edit button displays the Edit control point dialog box (Figure 32), where you can
modify the control point. T&A Point ID determines an unique control point’s ID. Thanks to this
ID, the change of the control point name will not influence the calculation results. T&A Point ID is
an arbitrary string. By default, when configuration is imported from PR Master, it gets the following
values: subsystem ID/controller ID/reader ID.

Edit control point [E3m]
T&A Point ID: | RN
Mame: Office buiding - EXIT
Commert 1:
Commert 2:

Cancel

Figure 32. The Edit control point dialog box

5.2.2.5. T&A event log

Opens the T&A event log window (Figure 33). In the top section of the window there is an event
list displayed in chronological order. By selecting dates Interval from: and To: in the upper
section of the window you can narrow down the time interval. In the details pane all information
relevant to the event is displayed, i.e: employee’s T&A ID, first and last names, pictures (where
assigned), group, time, control point and T&A event type.
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Apart from this data there are two flags with information if the events were added or deleted. If
you delete an event imported from file, then it will remain on the list as striken out and grayed-out.
On the other hand, deleting an event added by the program operator will completely remove it
from event list. A deleted event (imported from file) can be undeleted when required. In order to
do this, you should click on Undelete deleted T&A event on the toolbar in the Event log
window.

5 Emplovees' Tad event log

4+ o XK )| Interval From: ||:| v|T0: ||:| v|| 2 | S

Time Last name: First name Téi ID Group Control poink Code| Ewent bvpe Added Remoy

4 1/1/2008 5:54 &M | Buckner Thorvald m Office building - u T - Enkry nn 0
1/1/2008 6:00 AM | Arispe Anastatio 004 Team I Office building - ENTRY i} T - Entry O O
11112008 6:45 AM | Arispe Anastatio 004 Team I Office building - EXIT 100 |{Cigaretted b.., | [] O

11112008 6:52 AM | Arispe Anastatio 004 Team [ Office building - ENTRY 0 Téd, - Entry O |

T event: Thorvald Buckner

Eui 1|l Df6E|U|P Pl
Details |
e 1 X Remove [&] shortcuks: =» TA event IDs ﬂControI paints
Phata:
TeA ID: (005

First name: |Th0rvald |

g Last name: |Buckner |
Group: |TeamI |

{Missing) Tirme: |1,|'1,|'2DDS 5154 AM |

Event type: |[D] T - Enkry |

Contral point: |OFFice building - ENTRY |

Added b operatar

Removed

Figure 33. T&A event log window

Clicking on the Edit button opens T&A event editing window (Figure 34), but only the events added
by Operator are available for edition.

Edit T&LA event
Phoata:
Date: EIE-01-01 -
Time: 0354 £
Emploves: [ [005] Buckner Thorvald - ]
Evert type: [ hd ]
Control point: [Oﬁice building - EWNTRY "]

Figure 34. Edit T&A event dialog box

5.2.2.6. Home page

Opens the Home page containing three groups of commands.
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The Common tasks group (Figure 35) contains shortcuts for most commonly used program’s
commands:

¢ Open data file... — opens dialog box for selecting .rta data file.
¢ Create new data file... — opens dialog box for saving a newly created data file.
¢ Import T&A events — opens T&A data import wizard.

¢ Verify data completness... — invokes function for checking data completness
(assignment of calendars for all the employees, completness of arrivals and departures
registration) and displays results in the pane at the bottom of the main window.

¢ Find discrepancies against work regulation... — invokes function for checking
discrepancies against the work regulation (late arrivals, early departures, missing log
entries, exceeded minimum or maximum time limits) and displays results in the pane at
the bottom of the main window.

¢+ Employee report wizard — opens report wizard window for all the employees.
¢ Find employee... — opens the Find employee dialog box (Figure 36).

— Common tasks

= Open data file...
'i Create new data file...

Be Import TR&A events

" verify data completness...

44 Find discrepancies against work regulation...
£ Employee report wizard...

i i Find employee...

Figure 35. Common tasks area on the home page

ind empl

Famihy name, first name or employee T&A 1D

| ok || Cancel

Figure 36. Finding employee dialog box

If you enter the employee’s name (full or part) or the T&A ID, the program finds the employee in
the navigation tree, expands the group branch, the employee belongs to, selects the employee’s
branch and opens the employee’s document window.

The Recently opened group (Figure 37) contains paths for recently opened data files (*.rta):
Clicking the path will display a logon window and load data from the file selected.
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\ Recently opened

‘ Demo.rta \

Figure 37. Area Recently opened on the home page

The Help group (Figure 38) contains commands for displaying program documentation and for
getting help:

¢ Function description — opens document window with program’s function description.

¢ FAQ — opens document window with program functionality description in the form of
guestions and answers.

¢ Troubleshooting — opens document window with problems description together with its
solutions.

¢ Open example (demo) file... — loads sample data file (configuration and T&A events of
fictitious company) for testing program;s functionality.

| -Help
@ Function description
@ FaQ

E Troubleshooting

= Open example (demo) file...

Figure 38. Area Help on the home page

5.2.2.7. Navigation tree

Opens Navigation tree window (Figure 39) representing data as a hierarchical tree. The main
branches of the tree are the main RCP Master modules, namely: employee groups with employees,
work calendars, control points, and T&A event log. To quickly find an element of particular name in
the tree, you need to type the name (or its part) in the Find field (at the top of the window), and
press Enter, or click Search button located on the right side of the field (to find next occurences
of the name in the tree, you need to click the Search button as many times as the name is found).
Moving from element to element in the tree can be done using mouse or the keyboard (arrow
keys). Pressing Enter or double clicking the element in the tree opens the document assigned to
this element (i.e. clicking employee name opens employee’s document window).
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T Tree X
34 Find: c] B
=84 Groups

=88 All employees (11)

----- Q, [001] Arab Muhannad
..... £ [004] Arispe Anastatio
----- £ [010] Bonds Eliseo

----- Q, [005] Buckner Thorvald
] Chambless Rudi
] Chevere Lucinde
]
]
]
]

=
—
L)
[
e |

Corpuz Demelza
Gerstner Herbert
Huffrnan Allison
Mckay Branden
----- £ [009] Saenz Imelda
o8 Administration (2)
(-84 Design Team (2)
o Management (1)
o8 Team 1(2)
o8 Team 1T (2)
o8 Team III (2)
[—jﬁ Calendars
- 2008
|:—:|.£'] Control Points
gl [0/1/1] Indoors
&l [0/2/1] Office building - EXI
&l [0/1/0] Factory - ENTRY
..gl) [0/2/0] Office building - EN
=S T&A event log
N 0o
- £ January
. February

o Y oy R oy R s (Y oy [N o |

1 | L] | 3

Figure 39. Navigation tree

To display command list associated with the particular tree element, you need to right click it — the
context (shortcut) menu will be displayed (Figure 40).
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T{:_Tree K
&4 Find: B Ei|
=84 Groups

=82 All employees [11)
- & [001] Arab Muhannad
Arispe Anastatio
Bonds Eliseo
Buckner Thervald
Chambless Rudi
8, 00 nle
Corpuz Dg
Gerstner H
Huffman A
- Mckay Bra
£ [009] Saenz Ime
- ﬁ;’. Administration (2)
-8 Design Team (2)
-8 Management (1) |
£

£

£

Open

Edit employee

Remove employes

Assign calendar

Event log "Chevere Lucinde”

Report "Chevere Lucinde” » | Report "Vacation days"

© E

-8 Team 1(2) Report wizard...
o8 Team I1(2) T
o8 Team III (2)
=7 Ccalendars
- 2008
|:—jd.r.'_'l Contral Points
df'ﬂ [0/1/1] Indoars
w.dll [0/2/1] Office building - EXI
gl [0/1/0] Factory - ENTRY
d.""] [@/2/0] Office building - EMI
B&; T&A event log

- 2008
£ January
‘il February

Report "TA - days”

)

Report "TA - days in detail”

-

Report "TA - total hours at work by day”

Report "Total hours at work by day”

b o)

Report "Work regulation discrepancies”

a4 | 1 | 3

Figure 40. Shortcut menu associated with selected tree element

By clicking the selected menu item, we invoke the command for the element selected (e.g. you can
assign the calendar to employee using Assign calendar to employees command — Figure 41).

Assign calendar @I

Select calendar for assignment:

| Weekly 7-15 (2008) -|

[ OK ] [ Cancel ]

Figure 41. Assigning calendar to employee from the shortcut menu

5.2.2.8. Previous/Next document

If more than one document is opened at a time, then commands Previous and Next allow for
moving between them in the same order as they were opened.
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5.2.3. Tools menu

The Tools menu is shown in Figure 42.

Tools | Window  Help

= TE&A event type definitions
] T&Atype definitions
Calendar day type definitions

Program operators

Operator action history

Verify data completness

Find work regulaticn discrepancies

QPO KD L

Data file (Demo.rta) 3

Language

Options

Figure 42. The Tools menu

The commands of the Tools menu have been described in the following sections.

5.2.3.1. T&A event type definitions

Opens the T&A event type definitions window (Figure 43). The T&A event type determines how
the event logged by the control point will be interpretted, for example: arrival, departure, going out
on business. The event type is uniquely identified by the numerical code. You can define any
number of T&A event type definitions

1l
X

T&A event type definitions
=* Event type list

+ = X | @
Code Mame: |~
[ 0 T&A - Arrival
15 T&A -Departure =
17 T&A - Going out on business
51 Breakfast break T
52 Lunch break
20 Qvertime 1
21 Qvertime 2 -
Event type: TEA - Arrival X
1 of12 | b Ml

Details

B Edit X Remove

Code: 0

Mame:  T&A - Arrival

Figure 43. T&A event definition window
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Clicking the Edit button displays the Edit event type dialog box (Figure 44), where you can
modify the particular event type.

Edit event type [eE3m]

Code: |[i]

Mame: T&A - Amival

Cancel

Figure 44. Edit event type dialog box

5.2.3.2. T&A type definitions

Opens the T&A type definitions window (Figure 45). T&A type is used to determine attendance
type of the employee in the particular time. Sample attendance types are as follows: Work, Going
out on business, Breakfast, Overtime, On vacation, Sick leave, and so on. You can define
any number of attendance types.

The Details pane contains the following data about attendance type:
¢ Code — unique code identifying attendance type.
¢ Name — textual name.
¢ Color — color displayed in the calendar.

¢ Time period — it can get two values: Interval (it means, that the attendance type
determines time interval up to minutes — e.g. work, breakfast break, cigarette break,
overtime, etc.) or Day (indicates that the attendance type applies to the whole working
day e.g. vacation, sick leave, business trip, etc.).

¢ Start — (optional) determines the event type which start counting time for the particular
attendance type (e.g. the event — Arrival can begin the attendance type Work; the
event Going out on business can start the attendance type Out on business).

¢ Included into working hours — determines if the particular attendance type will be
included into working hours (e.g. breakfast break is included into working hours whereas
lunch break is not included; sick leave is included, but unpaid leave is not, and so forth).

¢ Leave — determines if the particular attendance type indicates leave — i.e. it is shown in
the Leave entitlements window for the particular employee.

+ Comments — additional info.
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-~ T&A type definitions s X
) Attendance ID list
+ = X R
Code Mame Comment 1 Time period Induded =
» 0 0 g No Dia W D
PP Outside work Outside work Interval [l
B s |Going out on business Going out temporarily to sart out business matters | Interval
SM Breakfast break Breakfast break Interval I
Attendance type: Work X
H 4 (1 of 22 | b
Details
B Edit X Remove [#] Shorteuts: = TA event IDs
Code: PR

MName:  Wark

Color:

Time period:  Day

[0] T&A - Arrival
Start: Induded into working hours
[7] Leave

Comment 1;  Working hours

Figure 45. T&A type definitions window

Clicking Edit button displays the Edit attendance type dialog box (Figure 46), where you can
modify the selected attendance type.

Edit attendance type E
Code:
Mame: Warlk
Color in calendar: -
Time period: [Da'_.f 7
Start (event type): [ [0] T&A - Amival hd

Included into working hours
[7] Leave

Comment 1:  VWorking hours

Comment 2:

Figure 46. Edit attendance type dialog box
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5.2.3.3. Calendar day type definitions

Opens the Calendar day type definitions window (Figure 47). Calendar day type is a pattern
(schedule) of work in the particular day — e.g. workday from 8:00AM to 5:00PM with a lunch break
(unpaid) from 1200PM to 1:00PM. Calendar day types, as the name suggests, are used for work
calendar definitions. Work calendar creation is the process of assigning day types to selected days
in the calendar — e.g. for all days from Monday to Friday the type: Workday 08:00AM-04:00PM can
be assigned. More about calendars can be found in the Calendars section.

Working day 7-15

Calendar day type definitions ¥ X
.3] Calendar day type list
+ & XA
Code Mame Start  End Type Comment 1 i

- DRE Working day 8-17 2:00 ... | 5:00... |Working Working day with flexible lunch break (1 h)
- oD7 Extra working day 7-15 7:00 ... |3:00... |[Extra working |Extra (non-obligatory) warking day E
DDa Extra working day 8-17 2:00 ... |5:00 ... |Extraworking |Extra {non-obligatory) working day with flexible...
Z1 06:00 - 1400 &:00 ... | 2:00 ... |Working Manufacturing (shift I) [
2 14:00 - 22:00 2:00 ... | 10:0... |Working Manufacturing (shift I1)
- 73 22:00 - 06:00 10:0... |6:00 ... |Warking Manufacturing (shift IIT) =
Calendar day type: Working day 7-15 X
H 4 |2 of11 | b M
Settings

E% Edit % Remove

[#] shortcuts: =] TA types/IDs

Times {constant): Breaks
Work start time: 7200 AM From To Attendance type
Work/shift end time: | 3:00 PM 9:00 AM  EHeWEG | | [SN] Breakfast break
Options:
Include late stay at work as working hours until the time:  7:00 PM Overtime (Fixed hours)
A Mark as late arrival after the time:  8:15 AM From To Attendance type
_L Mark as 'early departure’ before the time: 3145 PM 5:00 PM M1] Cvertime 1
Night hours {range) | 10:00 PF - | 6:00 AM 5:00FM | 7:00 PM [MN2] Overtime 2
Hours at wark i
Min. I¥an, Attendance type
12:15 AM | | [FNF] (Cigarette) break
Figure 47. Calendar day type definition window

Clicking the Edit button displays the Edit calendar day type dialog box, where you can modify
the selected calendar day type (Figure 48). The day type definition consists of the following fields:

¢ Code — unique code identifying day type.

¢ Name — unique name of day type.

¢ Color in calendar — color for representing the type of day assigned to the calendar.

¢ Comments — additional info.

¢ Type — it can get the following values: Working (indicates compulsory attendance at
work); Extra working (means extra working day which is not compulsory); Holiday
(means a public holiday); Day off (free day not counted in the calculations).
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¢ Hours — it can get two values determining the way of work: Fixed (work from defined
time to defined time); Flexible working hours (work type, where the start and the end
of the workday is not set; it is possible to define daily hours limit and the time of start/end
the workday — e.g. for accounting the flexible working hours during the night shift).

Edit calendar day type ==

Code: DDV
Mame: Bxtra working day 7-15

Colorin calendar: [N ~
Comment 1:  Extra {non-obligatony) working day
Comment 2:
Type
Warking
@ BExtra working (optional)
Huoliday
Day off
Times
@ Fied: Flexible working hours:
From: To: 08:00

07:00 & - 15:00 (£ 00:00

| M| Show details |

[ o] ] | Cancel |

Figure 48. Edit calendar day type dialog box

In addition, the day definition may contain configuration items which will be shown after clicking
the Show details button (Figure 49). Additional options are divided into the following tabs:

Options tab contains several options related to work time calculation, and showing information
related to the work regulation (schedule):

¢ Include early stay at work... — you can define the point of time (before the usual
working hours), from when the early stay at work will be included into working hours.

¢ Include late stay at work... — you can define the point of time (after the normal
working hours), until when the late stay at work will be included into working hours.

¢ Mark as late arrival... — you can define the point of time, from when the employee’s
arrival will be counted as late coming.

¢ Mark as early departure... — you can define the point of time, before when the
employee’s departure will be counted as early.

¢ Night hours — indicates the range which will be counted as night hours.
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Details

Options | Rounding | Regulatory breaks | Overtime | Hours at wurk|

Include eary stay at work as warking hours befare the time: 07-00 Iil

Includs late stay &t work as working hours urtil the time:  [112:00 |2 as overtime

Mark as late amival after the time: 08:15 |2

= b

Mark as ‘earty departure’ befare the time: 15:30 |2

Might hours frange)  22:00 |2 - DROD |2

| ok || Caneel

Figure 49. Work time calculation parameters — details
Regulatory breaks

Allows for definition of regulatory breaks, e.g. breakfast break (Figure 50). The program will
automatically count the work time within the range defined as the type indicated in the breaks list.

Details

| Options I Rounding | Regulatory breaks |D'u'ertime | Hours at wnrk|

¢ dh Add % Remove

Fom a« To Atendance type
10:00 AM [ 10:15 AM  ([ERIRE Rl A=

1:00 PM [FO] Lunch break

Figure 50. Regulatory breaks tab
Overtime

Allows for definition the overtime in the particular day (Figures 51 and 52). The program will
automatically count the work time as overtime according to the rules defined. There are two
methods of overtime counting:

Fixed hours: defined by selecting the hours range From-To. The Attendance type column
determines the overtime type accounted for in the particular time range (e.g. Overtime 1 — 50%,
Overtime 2 - 100% and so on).Variable hours: calculated dynamically (after the specific number
of hours has been worked through). Defined by indicating the number of hours worked through
after which the system should start counting the specific overtime type. For example: in the first
row of the Figure below, there is information that the overtime should be counted after 8 hours of
work — e.g. if an employee worked from 7:00 am to 4:00 pm, then the “Overtime 1” period starts
at 3:00 pm.
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Details

ok Add % Remove | Overtime count: ) Fixed hours @ Changing/flexible
Start after if an employee
having 4 has worked at Attendance type

worked for least for

[M1] Owertime 1 -
[MZ] Owerdime 2

Figure 50. Overtime tab — variable hoursAdditionally, the column If an employee has worked at
least for allows for defining even the most complicated overtime definition.

For example: we are supposed to define overtime in such a way that after 8 hours of work, the
overtime 50 % be counted (i.e., for example, Overtime 1). Additionally, if an employee worked
longer than two overtime hours (i.e more than 10 hours in total), then 100 % overtime should be
accounted for (i.e., for instance, Overtime 2) from the beginning of overtime period, so after 8
working hours. The method of defining this kind of overtime has been described below.Definition
example: In the window above, two overtime types have been defined. Both begin after 8 hours
of work. As an additional condition there is a statement, that the first overtime period should start
after an employee worked at least for 8 hours, the second after she/he worked at least for 10
hours. In Figure below there is work history for an employee who worked form 7:00 am to 4:50
pm. As you can see, the employee worked more than 8 hours, so the “Overtime 1” type were
accounted for.

Start Attendance type Event Control point Comment  Total time ;—Icnclsutr?tzs Far Edited
1/2/2008 Working day 7-15 TOTAL- 9:50 9:50
F:00 AM Work: T&A -Entry Office building - EMTRY a:00 &-00
3:00 PM Cwvertime 1 1:50 1:50
4:50 PM Outside work T&A -Leave | Office building - EXIT

On the other hand, if an employee worked more than 10 hours (e.g. from 7:00 am to 5:40 pm),
then the “Overtime 2" type should be accounted for him. This is according to the setting in the If

an employee has worked at least for
column.
Start Attendance type Event Control point Comment Total time ;—ersubgtgs for Edited
1/2/2008 Working day 7-15 TOTAL- 1040 10-40
7:00 AM Waork. T&A - Entry Office building - ENTRY 200 8:00
3:00 PM Overtime 2 2:40 2-:40
5:40 PM Outside wark T&A -Leave | Office building - EXIT

Allows for definition of overtimes in the particular day (Figure 51). In the current version, overtime
can be defined in the fixed time range. The program will automatically count the work time as

overtime,

rules.
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Details

| Options | Rounding I Regulatory breaks | Overtime | Hours at wark

i b Add % Remove | Overtime count: Fixzed hours Changing/flexi

Ta Attendance tvpe
200 PM |[N1] Overtime 1 -
FO00PM |[NZ] Overime 2

Figure 51. Overtime definition tab
Rounding

Allows for definition of roundings for the start and end of work times. In the sample shown in
Figure 52, the counting of the start has been set every 30 minutes, and the allowed time margin —
5 min. It means, that the employee’s arrival, e.g. at 7:50AM or 8:04AM will be rounded to 8:00AM,
but the arrival, e.g. at. 8:08AM will be rounded to 8:30AM. The options set for the end of work
have the following meaning: if departure took place at 3:55PM, it will be rounded to 3:45PM, but
departure at 3:59PM or 4:08PM will be rounded fo 4:00PM. Times rounded are visible in the
employee’s work history with a tilde mark — e.g. ~ 8:00.

Details

Options | Rounding | Regulatory breaks | Overtime | Hours at wurk|

Start of worl;

mir

Court start eveny:

Allowed amival afterthe star limit: (5 mir

[

Count end eveny: mir

Allowed departure before the end limit: |3 min

[

Figure 52. Rounding definition tab
Hours at work

Allows for definition of constraints list for times spent within the particular attendance types (see
Figure 53). For example, we can define maximum total cigarette break time, lunch breaks time or
define minimal expected work time hours.
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Options | Founding | Fegulatory breaks | Overtime | Hours at work,

i hadd X Remave

Do not count

Attendance pe kdin. b & when aboyve
TR
F  [PNF] [Cigarette] break v 1215 &M
[FO] Lunch break w 1:00 AM ]

Figure 53. Hours at work tab

Additionally, the Do not count when above maximum option allows limiting attendance time of
a specific type to the given maximum value. The time above this value will not be counted to the
total work time.

Sample 1. If we define that a maximum attendance time for the attendance time ,Breakfast” is 10
minutes, and we check this option, but the employee stays at breakfast 30 minutes, then the
program will subtract the time above 10 minutes (i.e. 20 minutes) from the total work time. So, in
this scenario, if the employee stays at work 8 hours, the program will count him only 7 hours and

40 minutes.
{ |1 of 143 | b bl | & Add . | [£] | view: := List of days || Calendar day details | = Total time ¥, Discrepancies |
Stark Attendance type Event Contral poink Canrnent Total tirme ;icnngﬁtgs For
w0 Wokingdey 75 0L &0z 740
7100 AmM . Work, T4 - Enkry Office building -... Z:00 2:00
2:00 AM Breakfast break 0:30 o:10
Maxirnum number of birs at work For
ﬁ the attendance tvpe "Breakfast 010
break! has been excesded
a:30 aM | [ [ wark 532 530
302 PM Qutside work, T&A - Leave Office building -...

Sample 2. If we define that a maximum attendance time for the attendance type ,Work” is 8
hours and we check this option, then the program will not count the time exceeding 8 hours to the
total work time of the employee. So that, if the employee who works from 7:00 AM to 3:00 PM
started her work at 7:00 AM and finished at 3:45 PM, then the program will count her only 8 work
hours (despite the fact that she stayed at work for 8 hours and 45 minutes).

| | 1 of 76 | | | 4+ add = | Bl | View: := List of days | =] Calendar day details | & Total time ., Discrepancies | =
) ) Time ko be
Stark Attendance bype Ewent Control poink Comment Tokal time ey e [
700 AM . Work, Téh - Entry | Office building - E.. 8:00
Maximumn numbe of brs at work for
ﬁ the atkendance type “Wark! has been a:00
excesded
345 PM Outside work Téh - Leave | Office building - E...

5.2.3.4. Program operators
Opens the Program operators window (Figure 54). In the top section of the window there is

operator list. The bottom section displays rights to execute particular program’s command defined
for the selected operator.
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Operator: ADMIN
| &l . | 1 Elf 2 b Pi

Arrcess rights

Program operators | ¥ X
!ﬁ Program operators

*+ & XA

Login -

» £

BILURO -

X

B Edit X Remove

g-#  File
E| ImportExpart
[ Import T&A event registration from another software
Import data
[¥]  Exportdata

g view

= /7183 Emplayee aroups
[, Browsing
[ 4k Adding
-.[¥[E Editing
JJ¥ Deleting
271 £ Employees
[, Browsing
-] 4 Adding
[V Editing

Figure 54. The Program operators window

Clicking the Edit button displays the Edit operator data dialog box (Figure 55). You can change
there the operator’s password, and select program’s commands available for her(him). In order to

do this you need to select relevant checkboxes in the program commands tree.
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Edit cperator data =
Login and password

Login: [ADMIMN

Old password:
Mew password:
Fetype new password:

Access rights

=¥  Fie "
Ellj Import/Export ‘

~[¥]  Import T&A event registration from another software
[ Import data M
.  Expotdata

=& View

= V88 Employee groups

-, Browsing

[ 4= Adding

[ Editing

X Deleting

=¥ & Employees

- [¥HQL, Browsing

[Fl &b fddime

m |

Cancel

Figure 55. Editing operator data

5.2.3.5. Operator action history

Opens the Operation history by operators window (Figure 56). In this window you can track
operator’s activities and commands which they invoked from the time they logged on, until the
moment of ending work with the application. The history contains also errors logged during
application’s activity. The operation history can be saved in .csv format (comma separated text file)
using the Save as... command.
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Operator action history | ¥ X
[ﬁ Operation history by operators
4 4 |1 ofdll [ b M |& | &2 H S
] Typ Time Login Code Description it
Browsing: Operator action history

240 H_|l,,J 1/11/2009 &;58:35 AM | ADMIN 29 | Closing edition window (Cancellation of changes): Edit oper...
339 L_y 1/11/2009 8:57:02 AM | ADMIN 30 |Opening edition window: Edit operator data
933 _11,) 1/11/2009 &:52:25 AM | ADMIN 31 [Browsing: Program operators
937 L_y 1/11/2009 8:52: 20 AM | ADMIN 29 | Clasing edition window (Cancellation of changes): Edit calen...
334 ng 1/11/2009 8:39:37 AM | ADMIN 30 | Opening edition window: Edit calendar day type
Q35 _11,) 1/11/2009 8:39:29 AM | ADMIN 29 | Closing edition window (Cancellation of changes): Edit calen...
934 L_y 1/11/2009 8:39: 16 AM | ADMIN 30 |Opening edition window: Edit calendar day type
233 HI,J 1/11/200% 8:3%: 13 AM | ADMIN 29 | Closing edition window {Cancellation of changes): Edit calen. ..
932 _11,) 1/11/2009 8:32:33 AM | ADMIN 30 |Opening edition window: Edit calendar day type
931 H-.lJ 1/11/2009 8:24:02 AM | ADMIN 31 |Browsing: Calendar day type definitions
230 HI,J 1/11/2009 8;23:53 AM | ADMIN 29 | Closing edition window (Cancellation of changes): Edit atten...
229 H_|l,,J 1/11/2009 8;22:27 AM | ADMIN 30 |Opening edition window: Edit attendance type
323 L_y 1/11/2009 8:17:43 AM | ADMIN 29 | Clasing edition window (Committing changes): Edit attendan...
a7 _11,) 1/11/2009 8:17:09 AM | ADMIN 30 |Opening edition window: Edit attendance type
926 4,) 1/11/2009 8:16:59 AM | ADMIN 29 | Closing edition window (Committing changes): Edit attendan...
325 ng 1/11/2009 8:16:44 AM | ADMIN 30 | Opening edition window: Edit attendance type
224 _11,) 1/11/2009 8:16:29 AM | ADMIN 31 |Browsing: T&A type definiions
923 L_y 1/11/2009 8:16: 27 AM | ADMIN 31 |Browsing: T&A event type definitions il

Figure 56. Operator action history window

5.2.3.6. Verify data completnes

Invokes function for checking data completness (i.e. assignment calendars for all the employees;
completness of arrivals and departures registration) and displays results in the pane at the bottom
of the main window. In the results window (Figure 57) you can click the Edit button and correct
data selected in the list.

,.-_i\, Incomplete data list fwithin a given time span) X
H 4|1 of6 | b Bl | [£] | Timerangs from: 1/1/2008 12:00:00 AM to: 1/31/2008 11:58:58 PM ~ | Edit
Typ Information i~

» L\, Calendar not assigned to employee: [003] Branden Mckay (Administration) L

Q Migsing entries in employee's wark history: [1] Muhannad Arab {(Managemeant)
g Migsing entries in employee’s work history: [2] Herbert Gerstner (Administration)

@ Mizsing entries in employee's waork history: [5] Demelza Compuz (Design Team) -

Figure 57. Results of data completness check

5.2.3.7. Find work regulation discrepancies

Invokes function for checking discrepancies against the work regulation (late arrivals, early
departures, missing log entries, exceeded minimum or maximum time limits) and displays results in
the pane at the bottom of the main window (Figure 58). When you double-click data selected in the
list in the result window, the employee’s document window is opened showing the discrepancies
details.
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_i\, Discrepancy list {within a given time span) X

1 of 10 | b Bl | 8] | S Time range: from: 1/1/2008 12:00:00 AM to: 1/31/2008 11:59:50 PM - | & Edit

Typ Information

3 ﬂ Discrepancies in employee’s work history: [1] Muhannad Arab (Management) ‘ = ‘

L\ Discrepancies in employee’s work history: [2] Herbert Gerstner (Administration)

L\ Digcrepancies in employes's work history: [£] Eliseo Bonds (Design Team)

L\ Discrepancies in employes's work history: [5] Demelza Copuz (Design Team) -

Ready

Figure 58. Discrepancy list pane
5.2.3.8. Data file menu

5.2.3.8.1. Change file access password

Displays password change window (Figure 59), where you can change password for the current
data file. The default password for newly created file is ,roger”.

Change file access password ==

Cumert file access password:

Mew password:

Fetype new password:

QK ] [ Cancel

Figure 59. Change file access password dialog box

5.2.3.8.2. Encrypt file

Displays a dialog box containing a question about encrypting or decrypting file. If you confirm, the
action selected will be performed.

5.2.3.8.3. Compact/repair file

Displays a dialog box containing a question about compacting and repairing file. If you confirm, the
action selected will be performed.

5.2.3.9. Language

Opens the RCP Master language selection window (Figure 60). The drop-down list contains all
the languages available for the program. After you select language, all the opened windows will be
translated, without closing them.
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i, RCP Master language selection |25

Select language:
| English -

[ OK J [ Cancel ]

Figure 60. RCP Master language selection dialog box

5.2.3.10. Change license

Displays a dialog box containing a question about removing the current license. If you confirm, the
current license is removed, and the program restarts in order to provide a new license in the start
window. The command is used e.g. for moving from one-user to multiuser license.

5.2.3.11. Options

Displays the Options window (Figure 61). The Mail settings tab is used for configuring mail
account for sending e-mail reports to employees.

=1 Mail settings! 9 Import RCP events|

Qutcoming mail server corfiguration (SMTF) - sending reports to

employess:
SMTF Server:
Port: 25
E-mail:

[] SMTP Server requires authentication
Login:

Password:

Figure 61. Options dialog box

The T&A event import tab (Figure 62) allows for configuration of quick event import from given
location after the operator logs on.
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Options |5
=
7 Mail settings| 6] Import RCP everts |

Impart RCP events automatically upan database logon

File to import:
o hevents rop Select..
Options:

i@ Replace duplicates with imported tems

i) Do nat import duplicates

Figure 62. T&A event import tab

5.2.4. Help menu

The Help menu is presented in Figure 63.

Help
About
(i) Program function description
@ FaQ
& Troubleshooting
i=  Release history
@ PFRoger home page
I Send feedback
'a Check for updates

Figure 63. Help menu

5.2.4.1. About

Displays dialog box with information about the program version.
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5.2.4.2. Program function description

Opens the RCP Master User Manual (PDF) in a built-in document view window. Acrobat Reader is
required for this functionality.

5.2.4.3. FAQ

Opens document window with program functionality description in the form of questions and
answers.

5.2.4.4. Troubleshooting

Opens document window with problems description together with its solutions.
5.2.4.5. Release history

Opens a document window with RCP Master release notes.
5.2.4.6. Roger home page

Displays the Roger Web site using the RCP Master's dokument window.
5.2.4.7. Send feedback

Opens default e-mail client with the vendor’s e-mail address and the subject, allowing for sending
feedback to the vendor.

5.2.4.8. Check for updates

Establishes connection with update server in order to check, if newer program version is available
for download.
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6. GLOSSARY

¢ Time and Attendance — set of technical and information technology media for
attendance control (presence/absence) during working hours (see also:
(http://en.wikipedia.org/wiki/Time and_attendance).

¢ Control point — a device for employee identification purposes using PIN codes readers,
code cards, proximity crds, biometric methods (fingerprints), etc.

¢ T&A event log — a list of events registered by control points.

¢ Data file compacting — deleting records in databases is performed by setting a flag
indicating that the particular record is deleted, not by physically removing the record
(physical removing records is very time-consuming operation). In order to delete records
physically, you need to invoke Tools/Data file/Compact/repair file command.
Compacting is performed mainly for lowering the size of data file.

¢+ T&A event type — determines how the event logged by the control point will be
interpretted, for example: arrival, departure, going out on business. The event type is
uniquely identified by the numerical code.

¢ T&A type — used to determine the attendance type of the employee in a particular time
range. Sample attendance types are: Work, Going out on business, Breakfast,
Overtime, On vacation, Sick leave, and so on.

¢ Calendar day type — a pattern (schedule) of work in the particular day — e.g. workday
from 8:00AM to 5:00PM with a lunch break (unpaid) from 1200PM to 1:00PM.

Contact
Roger sp. j.
82-416 Gosciszewo
Gosciszewo 59

Tel.: +48 55 272 01 32

Fax: +48 55 272 01 33
Technical support PSTN: +48 55 267 01 26
Technical support GSM: +48 664 294 087

e-mail: biuro@roger.pl
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